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2. Introduction 
 

 

References 

Document name Please refer to: 

PN531 v3.4 user 
manual 

107506.pdf (UM0301-06) 

PN531 v4.2 user 
manual 

(UM0501-02) 

PN531 C2 
Datasheet 

111903.pdf 

Mifare 
specification 

www.semiconductors.philips.com/markets/identification/datasheets/ 

DESfire 
specification 

M075031.pdf 

ISO14443 
specification 

(T=CL) 

ISO14443-3 specification 

ISO14443-4 specification 

NFCIP-1 
specification 

ISO18092 specification 

 

Glossary 

NFC    Near Field Communication 

TAMA   PN531 

HSU    High Speed UART 

SMX    Philips SmartMX (Memory Extension)  
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2.1 Software installation 
 

The smart card reader software install shield is located either in several floppy disks named: “SCRTester 
v1.X.X.X Disk 1/z” or in only one executable file with name describing the interface used. 
 
Procedure:   - Insert the first floppy disk and execute the setup.exe file or execute directly the 

executable file if you don’t use the floppy disks. 
- Follow the installation procedure with the default settings.  

 
 

2.2 New USB Driver installation 
 

Starting with PN531 C2 version 4.1 and above, it is recommended to use the new USB driver 
(PN531_USB.SYS). 
This new driver has passed USB certification.   
 
In case you have already installed the previous USB driver (USB_Test.sys) on your PC, you will need to 
follow the below procedure in order to properly install the new driver “PN531_USB.sys. 
 

Notes: It is not possible to use "update driver" functionality in the device manager, because the new 
driver has a different name, a different .inf, and a different category (now PN531 will appear directly 
under USB controller, not under smart card reader) 
 
 

Procedure: 
 

1)  plug PN531 board 
 
2)  Do "Uninstall..." in the device manager 
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The following message should appear: 
 

 
 
Press OK button to start the uninstall procedure 
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3) Unplug TAMA board 
 
4) Delete file "C:\WINNT\system32\drivers\USB_Test.sys" 
 
5) In the directory "C:\WINNT\inf", Edit all oem**.inf file and delete those who are related to USB_Test 
driver. Delete also corresponding "oem**.pnf" files. 
 
You are now ready to Install SCRTester using the installshield file “SCRTesterV1620_Full_TamaUSB.exe”. 
 

 
 
Proceed with “Next” button. 
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Select typical installation and proceed with “Next” button. 
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Install the generic USB driver. 
 
Connect the USB demo board then proceed with the Next button. 
 

 
 
If you have a look at the Windows Device Manager, the PN531 reader will be enumerated as below. 
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2.3 Software description 
 

SCRTester is a PC software allowing to communicate with a Philips smart card reader demo board 
through several links (RS-232 serial / USB/ I2C  or SPI). 

 

N° 1 

N° 2

This software is composed of 2 views, 9 toolbars and several menus.  
 
The first view (N°1) shows selected card ATR and the firmware release. The second one (N°2) is split in two 
parts. The top view is used to implement a script file and the bottom one to see each command answer. 
 
The toolbars allow a quick access to the main commands, for example PowerUp command or Mask command. 
All commands are described in the Commands description section. 
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3. Getting Started 
 
This part explains how to use this software with a Philips Semiconductors serial or USB demo board. 
First, close all windows to see the following situation. 
 
New serial, USB, PC/SC, I2C or SPI device 
 
 Click on the “New” button:  

 
You can also use “New” in the “File” menu.  
 

 
 
A dialog box offers you several link to connect you reader, choose the communication type. 
Select the right type for your smart card reader and proceed with OK button. 
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3.1 Protocol Initialisation 
 
Select the correct protocol in the “Protocols” menu. After this initialisation, you can see all available basic 
commands in the same menu. 
 
For example, you can choose the Alpar protocol for an ALPAR serial reader: 
 
Before initialisation:  After initialisation:  
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3.2 Command type selection 
 
Select the command type in the “Script” menu. Choose “Command”. 
 

 
 

3.3 Protocol mode 
 
Select the protocol mode in the submenu “Mode” in the “Protocols” menu. 
The correct mode to use is referenced in the demo board application note. If the mode is not referenced in the 
application note, choose the “Standard” Mode. 
With TAMA protocol, sub menu Mode is not available so select the Handshaking Mode using “ESM EN-RQ” 
buttons below.  
 
Rem : You can also use these buttons 

: 
   

 

3.4 Protocol standard 
 
Select the protocol standard in the submenu “Standard” in the “Protocols” menu. Choose “ISO”. 
For more details about the standard to use, refer to the demo board application note. 
This menu is not available with TAMA protocol. 
 
Rem : You can also use these buttons : 

  

 

 

3.5 Reader Initialisation  
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Click on “Connect” in the “Reader” menu. Each type of reader has a specific menu. If you use a serial smart 
card reader, you can also choose the serial setting in the same menu. The default serial configuration is 
normally correct. If it is not the case, see the demo board application note. For a USB reader, you don’t have 
specific settings. You just have to select the “Connect” menu. 
With either I2C or SPI readers, an option menu allows changing the interface set-up. 
 

3.5.1 I2C interface 
 
I2C settings:  

 
 
Select the I2C options. 

 
 I2C options:   
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3.5.2 SPI interface 
 
SPI settings:  

 
 
Select the SPI options. 

 
SPI options:  
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3.5.3  Serial and USB interface 
 
Serial settings:  USB settings:  
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3.6 First test 
 
For testing the initialisation, Click on the “Mask number” button:   

 
After that, you can see the command sent to the reader and the answer frame in the output view. 
 

 

3.7 Script execution. 
 
Clear all data in the output view by clicking on the button:   

  
Open the test script file, named “Mifare Std.cmd”, by clicking on the 

button:  
 

  
Execute the script step by step by clicking on the button:   

  
Execute the script sequentially by clicking on the button:   
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3.8 General view 

 

 
 

 

 

 

- Connect : create a link to 
the device driver. 
- Disconnect : delete the link

Script view : allows to write or 
to load a script with several 
commands for a specific smart 
card. 

Toolbars with respectively the : 
- Start button (F5) (begin to end) 
- Step button (F10) (step by step) 
- Stop button (Esc) 
- Breakpoint button (F9) 
- Loop button (ctrl+L) (begin to end in loop)

Output view : Allows to display the command 
sent (PC->IFD) and the answer received (IFD-
>PC) 

The yellow array :  
indicates the next 
command to be executed. 

 

 

 

 

Parameters view : Allows to display the Answer To 
Reset card (ATR) decoding (specific smart card 
parameters), when using contact readers and the 
Mask Number of the reader component. 
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4. Script File Description 
 
The script view allows to write several commands that are sent to the smart card reader.  

- To send the commands step by step, use the “F10” key or the “Step” button:         

- To send the script from the beginning to the end, use the “F5” key or the “Start” button:  

- To send the script in loop mode, use the “Ctrl+L” key or the “Loop” button:  before the “Start” button. You 
can also use the specific command “.loop;” in the script. For more details, see the help file (“F1” key). 

- To stop the script execution, use the “Esc” key or the “Stop” button:  

4.1 Commands 
 

A command is composed of bytes in hexadecimal value. Each byte is represented by 2 characters, for instance: 
02 = 0x02, and each byte is separated by a space character. End of the command is specified with a semi 
coma character and a command can be separated in several lines. 
It is possible to use ASCII characters. These ones are put in quotation marks. 
You will find bellow some command examples for the TAMA protocol. 
 

//“Mask number” command : 

00 00 FF 02 FE D4 02 2A 00; 

//Same command : 

00 00 FF 02 FE  

D4 02 2A 00; 

 

//“APDU” command : 

// InDataExchange - Tg = 1 

40  01  00 01 02 03 04 05 06 07 08 09 "1234"; 

//Same command : 

40  01  00 01 02 03 04 05 06 07 08 09 31 32 33 34; 
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4.2 Comments 
 

The comments begin after a “*” character or a “/” character. 
When they are used, all characters after them are in green color. 
 

//“Mask number” command : 

00 00 FF 02 FE D4 02 2A 00; 

*Same command : 

00 00 FF 02 FE\ beginning of the command 

D4 02 2A 00; * end of the command 

 

 

4.3 Special commands line 
 

Several commands can be used in the script file. Each command line is represented by a particular syntax that 
must be respected. In the script file, those commands are represented in red color. 
 
“.b;” 
This command line allows to insert a breakpoint in the script file. 
 
“.rawdata;” 
This command line allows to enable the “Raw Data” mode. (For more details, see the end of “Script Menu” 
description) 
 
“.apdu;” 
This command line allows to enable the “APDU” mode. (For more details, see the end of “Script Menu” 
description) 
 
“.command;” 
This command line allows to enable the “Command” mode. (For more details, see the end of “Script Menu” 
description) 
 
“.save;” 
This command line allows to save the log file (output view) using the same name as the script file with a “.log” 
extension. 
 
“.loop;” 
This command line allows to enable the loop mode. 
 
“.trace(on);” 
This command line allows to enable the display in the output view. This functionality is enabled by default.  
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“.trace(off);” 
This command line allows to disable all display in the output view. 
 
“.info;” 
This command line allows to show the script file name, the date, the time and the number of loop executed. 
 
“.t(0);” 
This command line allows to disable the delay between each command if it had been implemented in the delay 
options dialog box. 
 
“.t(xxx);” 
This command line allows to fix a delay between each command to be sent. “xxx” is the delay value in Microsoft 
mSec. This delay is also available in the delay options dialog box. 
 
“.start_duration;" 
This command allows to start a software counter to measure a time. It works with the “stop_duration” and the 
“display_duration” functions. 
 
".stop_duration;" 
This command allows to stop a software counter to measure a time. It works with the “start_duration” and the 
“display_duration” functions. The “start_duration” function must be used before it. 
 
".display_duration;" 
This command allows to display the time measured between a “start_duration” and a “stop-duration”. 
 
".clear;" 
This command allows to clear the output view. 
 
".config(code, code1, Buffer);" 
This command is link dependent. Each type of reader (serial, USB, I2C,PC/SC) implements several commands. 
 
Serial reader:  the command “.config( 00, 115200 );” allows to switch to a specific baud rate. In this case, the 
baud rate is 115200 bps. It can be modified by another valid baud rate. 
USB reader: no specific command available. 
I2C reader: This command allows to read/write to a specific I2C address. 
 - .config( 0, 40, AA );  : allows to write the (AA)h byte to the I2C address (40)h. 
 - .config( 1, 41);  : allows to read the byte at the I2C address (41)h 
 - .config( 1, 41,AA);  : allows to read the byte at the I2C address (41)h. Then, the      byte read is 
compared to (AA)h . If there is a difference, an  
      error message is displayed in the output view. 
PC/SC reader: no specific command available. 
 
".escape(CTL_CODE, Buffer);" 
This command is only available with a PC/SC device. It allows sending an IOCTL command to the PC/SC 
driver. The CTL_CODE is normally specified in the PC/SC driver documentation. The Buffer parameter is used 
to provide specific data to the PC/SC driver. 
 
Opcodes and Error codes 
 
Opcodes and error codes are different depending on the reader used. 
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For example, in all ALPAR readers, the opcode is coded in the third byte. The explanation of all ALPAR 
opcodes is given in a text file, named command.txt. This file is also used to display the name of each command 
in the output view. If the command is wrong, the reader answers with an error code. All error codes are defined 
in the error.txt.  
For a PC/SC reader, there is no opcode used, errors are provided by the Microsoft Smart Card Resource 
Manager. 
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5. Commands description 

5.1 Menu 
 
The following menu can be used: 
 

• File Menu 
• Edit Menu 
• Script Menu 
• Command Menu 
• Protocol Menu 
• Reader Menu 
• View Menu 
• Tools Menu 
• Windows Menu 
• Help Menu 
 

5.1.1 File Menu 
 
The File menu offers the following commands: 
 

 
 
 
 
New Creates a new document (through Serial or USB link). 
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Creates an empty document New Script File 
Open Opens an existing script File. 
Close Closes an opened document. 
Save Script File Saves an opened script using the same file name. 
Save Script File As Saves an opened script to a specified file name. 
Save Log File Saves the log file using the script file name  
Save Log File As Saves the log file to a specified file name 
Print Prints the log file View. 
Print Preview Displays the log file on the screen as it would appear printed. 
Print Setup Selects a printer and printer connexion. 
Exit Exits SCRTester 
 
 
 

5.1.2 Edit Menu 
The Edit menu offers the following commands: 
 

 
 

Not implemented. Undo 
Not implemented. Redo 
Deletes data from the document and moves it to the clipboard. Cut 
Copies data from the document to the clipboard. Copy 
Pastes data from the clipboard into the document. Paste 
Deletes data. Delete 
Selects all data. Select All 
Not implemented. Find 
Not implemented. Replace 
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5.1.3 Script Menu 
 
The Script menu offers the following commands: 
 

 
 
• Insert/Remove BreakPoint :  

Inserts or removes the break point on the current script command. 
Shortcuts: 

Toolbar:  

Keys: F9 
 
• Starts or continues the script: 

Starts or continues the script execution. 
Shortcuts: 

Toolbar: 
 

Keys: F5 
 
• Stops script execution:  

Stops the script execution. 
Shortcuts: 

Toolbar:  

Keys: Esc 
 
• Single step:  

Executes the current command. 
Shortcuts: 

Toolbar: 
 

Keys: F10 
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• Loop:  

Activates the loop Mode. 
When the end of the script is reached, the script will continue from the beginning indefinitely. 
Shortcuts 

Toolbar: 
 

Keys: Ctrl+L 
 

• Set next statement:  
Selects the command where the cursor is. 
Shortcuts 

Toolbar: 
 

Keys: Double Click on the command 
 
• Show next statement:  

Not implemented. 
 

• Delay Options:  
Shows the “Delay Options” dialog box. 
Shortcuts 

Toolbar: 
 

Keys: Not implemented 
 

• Cyphering: 
Shows the “cyphering” dialog box. 
 

Shortcuts 
Toolbar: 

 
Keys: Not implemented 

 
• Raw Data:  

Selects the Raw data Mode. 
This mode allows to send the script commands without any protocol. 

      Script data: 60 00 00 0A 6A --> data sent: 60 00 00 0A 6A 
 
• Commands:  

Selects the command Mode. 
This mode allows sending the script commands with an encapsulation of the selected protocol.  

 
      Script Data: 6E 00;  --> data sent: 60 00 01 6E 00 0F 
       ---- : Alpar Protocol encapsulation 

 
• APDU:  

Selects the APDU Mode. 
This mode allows to send an APDU command with an encapsulation of the selected protocol and the APDU 
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Opcode. 
 

      Script data: 00 00 B0 00 00 40; --> data sent: 60 00 05 00 00 B0 00 00 40 95 
      ---- : Alpar Protocol encapsulation 
      ---- : APDU Opcode ( ALPAR Protocol ) 

 
 

5.1.4 Command Menu 
 
The Command menu offers the following commands: 
 

 
 
• Command setting:  

 
  Displays the “Command Setting“ dialog box to define an owner command. 
 
• Command 1:  - Keys: Ctrl+F1 - 

 
  Allows to send the predefined command in the Command Setting dialog box 

 
• Command 2:  - Keys: Ctrl+F2 - 

 
  Allows sending the predefined command in the Command Setting dialog box 

 
• Command 3:  - Keys: Ctrl+F3 - 

 
  Allows to send the predefined command in the Command Setting dialog box 
 
• Command 4:  - Keys: Ctrl+F4 - 

 
  Allows to send the predefined command in the Command Setting dialog box 
 
• Command 5:  - Keys: Ctrl+F5 - 

 
  Allows to send the predefined command in the Command Setting dialog box 
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5.1.5 Protocol Menu 
 
The Protocol menu offers the following commands: 
 

 
 

Select this menu item to use the ALPAR USB protocol. • Alpar USB:  

 
Select this menu item to use the ALPAR protocol. • Alpar:  

 
Sends the “Mask Number” command corresponding at the 
selected protocol. (See the demoboard application note). 

• Mask:  

 
Use this popup menu to change the activation mode ( ISO / 
EMV ) 

• Standard:  

 
• Power:  Use this popup menu to manage the power commands:  

¾ Asynchronous card: 
- Power Down. 
- Power Up 5V. 
- Power Up 3V. 

¾ Synchronous card: 
- I2C 
- S9 
- S10 
- Euro 
- Gpm: Fuse 0 (896) 
- Gpm: Fuse 1 (896) 
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Use this popup menu to select a smart card ( 1 to 6 ) • Select:  

 
• Mode:  Use this popup menu to change the standard mode :  

Standard. 

ESM Char. 

ESM En_Req. 

 
• Loopback:  Use this popup menu to use the loopback functionality. 

Loopback EMV. 

Loopback GIE. 

 
Rem:    All protocols are managed dynamically by using a DLL. 

Alpar USB Protocol: proAlparUSB.dll 
Alpar Protocol: proAlpar.dll 
TAMA protocol: proTAMA.dll 
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5.1.6 Reader Menu 
 
This menu gives you the possibility to set up the communication port (Serial, USB, I2C, PC/SC). 
 
 
 
USB reader: 

 

 
 
Initiates or closes the communication with the USB 
device driver. 

 
 
I2C reader: 

 

 
 
 
Connects the reader to the PC via the LPTx port 
management.  

The I²C lines are emulated using the PC parallel pins. 

The lines configuration ((SCL, SDA) can be set up using 
the I²C option menu. 

 
 
 

 
 
PC/SC reader: 

 
 
 
The reader menu of the PC/SC board allows the 
selection to the PC/SC reader. In fact, all PC/SC drivers 
loaded by the Microsoft Resource Manager are 
mentioned dynamically in the menu. The user selects 
the reader and the possible card protocol to use and 
initiate the communication by the “connect” menu. 

When the reader is connected, the ATR of the card is 
displayed and decoded by SCRTester. 
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Serial menu: The serial menu allows the user to select the 

communication parameters. See the application note of 
the reader used to know the parameters to be used. 
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5.1.7 View Menu 
 
The View menu offers the following commands: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Toolbar: Shows or hides the toolbar. 

 
Use this command to display and hide the Toolbar, which includes 
buttons for some of the most common commands in SCRTester, 
such as File Open.  A check mark appears next to the menu item 
when the Toolbar is displayed. 
 

Status Bar: Shows or hides the status bar. 
 
Use this command to display and hide the Status Bar. 

 
 

5.1.8 Tools Menu 
 
The Tools menu offers the following commands:  
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Auto Pause Select this menu item to stop the script automatically on an error. 
Beep Select this menu item to hear a beep on an error. 
Clear Log View Clears the current output view. 
Get Pnp ID Generates a Plug and Play sequence on the current serial port. 
Options… Not implemented. 

  
 

5.1.9 Windows Menu 
 
The Window menu offers the following commands, which enable to arrange multiple views of multiple 
documents in the application window: 
 

 
 
New Window: Creates a new window that views the same document. 

 
Use this command to open a new window with the same contents 
as the active window.  You can open multiple document windows 
to display different parts or views of a document at the same time.  
If you change the contents in one window, all other windows 
containing the same document reflect those changes.  When you 
open a new window, it becomes the active window and is displayed 
on top of all other open windows. 
 

Cascade: Arranges windows in an overlapped fashion. 
 
Use this command to arrange multiple opened windows in an 
overlapped fashion.  
 

 

 © Koninklijke Philips Electronics N.V. 2006 
All rights are reserved. Reproduction in whole or in part is prohibited without the prior 
written consent of the copyright owner. The information presented in this document does 
not form part of any quotation or contract, is believed to be accurate and reliable and may 
be changed without notice. No liability will be accepted by the publisher for any 
consequence of its use. Publication thereof does not convey nor imply any license under 
patent- or other industrial or intellectual property rights. 

Date of release:9 Jan 2006
Document order number: <12NC>

Published in The Netherlands 

 



 

Philips Semiconductors  UM0201_5
   SCRTester user Manual

Tile: Arranges windows in non-overlapped tiles. 
 
Use this command to arrange multiple opened windows in a non-
overlapped fashion. 
 

Arrange Icons: Arranges icons of closed windows. 
Window 1, 2...: Goes to specified window. 
 

5.1.10 Help Menu 
 
The Help menu offers the following commands, which provide you assistance with this application:  
 
Contents:  Offers an index on topics on which you can get help. 

Displays the version number of this application. About:  
 

5.2 Toolbar 
 
The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar provides 
quick mouse access to many tools used in SCRTester 
 
To hide or display the Toolbar, choose Toolbar from the View menu. 
 
Click To: 
 

Create a new device document. 
 

  
Create a new script file. 

 
  
Open a script file. 

 
  
Save the active script document with its current name. 

 
  
Remove selected data from the document and stores it on the clipboard. 

 
  
Copy the selection to the clipboard. 

 
  
Insert the contents of the clipboard at the insertion point. 

 
  
Print the active output document. 

 
 

Start/Continue the script execution. 
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Execute the next script command. 

 
  

Stop the current script execution. 
 

  
Insert/Remove a breakpoint. 

 
  
Enable the loop script mode. 

 
  
Set Next Statement. 

 
  
Display the “Delay options” dialog box. 

 
  
Display the “Cyphering” dialog box. (internal use) 

 
 

Send a “Mask Number” command. 
 

  
Send a “Power OFF“ command. 

 
  

 
Send a “Power ON 5V” command.  
NOTE : If the selected  reader is PC/SC, the activation will always be a WARM reset. 
  
Send a “Power ON 3V” command. 

 
 

Enable the EMV activation mode. 
 

  
Enable the ISO activation mode. 

 
  
Enable/Disable the Auto Pause Mode. 

 
  
Enable/Disable the beep on error. 

 
  
Clear all data in the output view.  
  
Enable/Disable the ASCII/Hex display in the output view. 

 
  
Allow reading or writing to the reader register.  
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Enable the “Standard” Mode. 
 

  
Enable the Enable-Request Energy Saving Mode. 

 
  
Enable the Char Energy Saving Mode. 

 
 
 

Start the EMV Loopback test mode. 
 

  
Start the GIE Loopback test. 

 
 
 

Display the “Command Setting” dialog box. 
 

  
Send the command 1. 

 
  
Send the command 2. 

 
  
Send the command 3. 

 
  
Send the command 4. 

 
  

Send the command 5. 
 

 
 

Send a “select card 1” command. 
 

  
Send a “select card 2” command. 

 
  
Send a “select card 3” command. 

 
  
Send a “select card 4” command. 

 
  
Send a “select card 5” command. 

 
  
Send a “select card 6” command. 
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Send a “Power Up I2C” command. 
 

  
Send a “Power Up S9” command. 

 
  
Send a “Power Up S10” command. 

 
  
Send a “Power Up Euro” command.  
  
Send a “Power Up Gpm 896 with Fuse 0” command.  
  
Send a “Power Up Gpm 896 with Fuse 1” command. 
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5.3 Specific use 
 

5.3.1 New command (File menu) 
 
Use this command to create a new device document in SCRTester.  Select the link you want to create in the 
new dialog box.   
 

 
 
Each device is managed dynamically by adding its DLL file. When the application starts, the DLL devices are 
loaded and usable.  
If there is only one DLL device in your SCRTester application, for example a serial device (BrdSerial.dll), the 
device is created automatically without dialog box! 
 
 
Thereafter, you can open an existing script file with the “Open” command. 
 
Shortcuts 

Toolbar:  
Keys: CTRL+N 

 
 

5.3.2 Open command (File menu) 
 
Use this command to open an existing script file in the current window.  
You can create a new document with the “New” command. 
 
Shortcuts 

Toolbar:  
Keys: CTRL+O 
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5.3.3 Command Setting Dialog Box 
 

 
 
 
Use this dialog box to define 5 new commands that are usable from the menu “Command” or by its toolbar.  
 
 

5.3.4 Alpar USB Protocol 
 
This command is used to select the ALPAR USB Protocol. This protocol is made by Philips Semiconductors 
and is used to communicate with the USB smart card readers demo boards. For more details, see the demo 
board application note. 
 
When the ALPAR USB Protocol is selected, all commands of this protocol are enabled and can be used. These 
commands are situated below the separator in the same menu and are described in the chapter named 
“Protocol Menu”. 
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5.3.5 Alpar Protocol 
 
This command is used to select the ALPAR Protocol. This protocol is made by Philips Semiconductors and is 
used to communicate with the SERIAL smart card readers demo boards. For more details, see the demo 
boards application note. 

 
When the ALPAR Protocol is selected, all commands of this protocol are enabled and can be used. These 
commands are situated below the separator in the same menu and are described in the chapter named 
“Protocol Menu”. 
 

5.3.6 PC/SC Protocol 
 
This command is used to select the PC/SC Protocol. This protocol can be used with all PC/SC readers, which 
provide a PC/SC compliant driver. It must only be use with a PC/SC device created by the new command of 
SCRTester. 

 
When the PC/SC Protocol is selected, all commands of this protocol are enabled and can be used. These 
commands are situated below the separator in the same menu.  
 

5.3.7 TAMA Protocol 
 
This command is used to select the TAMA Protocol. This protocol is a proprietary protocol made by Sony and is 
used to communicate with the TAMA demo boards. For more details, see the demo boards application note. 

 
When the TAMA Protocol is selected, all commands of this protocol are enabled and can be used. These 
commands are located below the separator in the same menu and are described in the chapter named 
“Protocol Menu”. 
 

5.3.8 Standard Menu 
 
For contact reader only. 

 
 

 

 © Koninklijke Philips Electronics N.V. 2006 
All rights are reserved. Reproduction in whole or in part is prohibited without the prior 
written consent of the copyright owner. The information presented in this document does 
not form part of any quotation or contract, is believed to be accurate and reliable and may 
be changed without notice. No liability will be accepted by the publisher for any 
consequence of its use. Publication thereof does not convey nor imply any license under 
patent- or other industrial or intellectual property rights. 

Date of release:9 Jan 2006
Document order number: <12NC>

Published in The Netherlands 



 

Philips Semiconductors  UM0201_5
   SCRTester user Manual

 
• ISO:   Select this menu item to use the ISO activation mode. 

  Shortcuts: 
Toolbar: 

 
Keys: Not Used 

 
• EMV:   Select this menu item to use the EMV activation mode. 

  Shortcuts: 
Toolbar: 

 
Keys: Not used 

 

5.3.9 Power Menu 
 
For contact reader only. 

 
 
• Off: Sends a Power off command. 

  Shortcuts: 
Toolbar: 

 
Keys: Not used 

 
• On Async.:  Use this popup menu to send a power up 5V or a power up command. 
 
• On Sync.:   Use this popup menu to send a synchronous power up command. 
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5.3.10 On Async. Menu 
 
For contact reader only. 

 
 
• 3V: Sends a power up 3-volt command. 

Shortcuts: 
Toolbar: 

 
Keys: Not used 

 
• 5V:  Sends a power up 5-volt command.  
NOTE: If the selected reader is PC/SC, the activation will always be a WARM reset. 

Shortcuts: 
Toolbar: 

 
Keys: Not used 

 

5.3.11 On Sync. Menu 
For contact reader only. 
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I2C:  Sends a power up command for an I2C smart card.
 

S9:  Sends a power up command for an S9 smart card. 
 

S10:  Sends a power up command for an S10 smart 
card.  

Euro.: Sends a power up command for an Euro ship 
smart card.  

Gpm: Fuse 0: Sends a power up command for a Gpm 896 smart 
card with fuse blown.  

Gpm: Fuse 1: Sends a power up command for a Gpm 896 smart 
card with fuse not blown.  

 

5.3.12 Mode Menu 
 

 
   
 
• Standard: Select this menu item to use the Standard Mode. This mode must be used for all demo boards 

that do not support the ESM Mode (ESM = Energy Saving Mode: see the demo board 
application note for more details). 
 
Shortcuts: 

 
Toolbar: 

Keys: Not used 
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• ESM EN_REQ: Contact reader 
 
Select this menu item to use the Enable-Request Energy Saving Mode. 
In this mode, outside an exchange of commands between the host (PC) and the demo board, the card clock is 
either switched off (level high or low) or set to Fint/2 depending on the clock stop mode described in its ATR. If 
the card does not support the clock stop mode or does not specify it, the clock is set to Fint/2. 
Just after having changed the card clock, the demo board micro controller puts itself in power down mode. 
A low level pulse on MMI_EN - DTR or any card event (extraction or insertion, over current on VCC or RST, 
overheating) will wake it up.   

 

MMI_EN (DTR)

DSR)MMI_REQ (

RX

TX

Communication initiated by the PC.

MMI_EN (

MMI_REQ (

RX

TX

DTR)

DSR)

Communication initiated by the DemoBoard.

PWDN

PWDN

CLK STOP or Fint/2 XTAL/n

CLK STOP or Fint/2 Card deactivated
Hardware
problem

t1 t2 t3 t4 t6t5 t7 t9t8 t11 t12t10

 
---- : demoboard signal 
---- : PC signal 
 
Shortcuts: 

 
Toolbar: 

Keys: Not used 
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• ESM EN_REQ: Contact less reader 
 

When using SCRTester with TAMA Readers, this menu allows using the Enable-Request Energy Saving 
Mode. 

For further details regarding this mode refer to the TAMA User Manual.  

 
• ESM Char: Contact reader 
 
Select this menu item to use the Char Energy Saving Mode. 

 
In this mode, outside an exchange of commands between the host (PC) and the Demo board, the card clock is 
either switched off (level high or low) or set to Fint/2 depending on the clock stop mode described in its ATR. 
Just after having changed the clock of the card, the Demo board micro controller puts itself in power down 
mode. A new received command from the host controller (PC) or any card event (extraction or insertion, over 
current on VCC or RST, overheating) will wake it up. 
In this case, the wake up is made with a specific command and not by DTR-DSR signals using. 

RX 

TX 

Communication initiated by the PC. 

RX 

TX 

C  ommunication initiated by the Demoboard.

PWDN 

PWDN 

KCL  STOP or Fint/2 XTAL/n 

KCL  ST COP or Fint/2 ard deactivated
dware 

ent
har
ev  

OpCmdFr 

OpAnswFr 

InformationalFr 

11t  t  8 t9 t10

0xAA 

AcqFr 

AcqFr 

UpFr

t12 

Wk  

 
Shortcuts: 

 Toolbar: 

Keys: Not used 
 

5.3.13 Loopback Menu 
 

 
 
• EMV: Starts or stops the Loopback EMV test. This test is necessary for an EMV 

certification. 
The test is finished either when the message “LOOPBACK : TEST OK” is displayed or when an error 
is returned. 
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Shortcuts: 

 
Toolbar: 

Keys: F10 
 
• GIE:  Starts or stops the Loopback GIE test. This test is necessary for an GIE certification. 

The test is finished either when the message “LOOPBACK : TEST OK” is displayed or when an 
error is returned. 

 
Shortcuts: 

 
Toolbar: 

Keys: F11 
 
 

5.3.14 Delay Options 
 

his Dialog box allows changing several communication parameters. The first one, named “Command 
the 

5.3.15 Cyphering 
 

eserved for internal use! 

 
T
delay”, is used to put a delay in milliseconds between each script command sent. The second one and 
last one are reserved for internal use. 
 
 

R

 

 © Koninklijke Philips Electronics N.V. 2006 
All rights are reserved. Reproduction in whole or in part is prohibited without the prior 
written consent of the copyright owner. The information presented in this document does 
not form part of any quotation or contract, is believed to be accurate and reliable and may 
be changed without notice. No liability will be accepted by the publisher for any 
consequence of its use. Publication thereof does not convey nor imply any license under 
patent- or other industrial or intellectual property rights. 

Date of release:9 Jan 2006
Document order number: <12NC>

Published in The Netherlands 

 



 

Philips Semiconductors  UM0201_5
   SCRTester user Manual

6. Specific USB behaviour 

6.1 Active suspend and remote wake up 
 
SCRTester supports the active suspend mode and the remote wake up. When the device works, for example in 
loop mode, you can go to the suspend mode. To wake up the PC, extract or insert the smart card. 
 
After the wake up, the following message appears: 
 

 
 

As explained in this message, to restart the script execution after resuming from the suspend mode, you have 
to reconnect the reader by using the “Reader : Connect” menu item. Then you will be able to start the script 
execution as explained in the script use part. 
 
If you have several hubs and USB devices on the same host controller, the enumeration can take a long time. 
You have to try again this procedure in a few seconds if the message reappears. 
 
 

6.2 Hot detach and reattach 
 

The hot detach and reattach is supported by the system. If the hot detach is performed during the script 
execution, the message above appears. After the reattach, you have to connect the software by the “reader-
connect” menu item.

 

 

 © Koninklijke Philips Electronics N.V. 2006 
All rights are reserved. Reproduction in whole or in part is prohibited without the prior 
written consent of the copyright owner. The information presented in this document does 
not form part of any quotation or contract, is believed to be accurate and reliable and may 
be changed without notice. No liability will be accepted by the publisher for any 
consequence of its use. Publication thereof does not convey nor imply any license under 
patent- or other industrial or intellectual property rights. 

Date of release:9 Jan 2006
Document order number: <12NC>

Published in The Netherlands 

 


	1. Content
	1.  
	2. Introduction
	2.1  Software installation
	2.2 New USB Driver installation
	2.3  Software description

	3.  Getting Started
	3.1 Protocol Initialisation
	3.2  Command type selection
	3.3 Protocol mode
	3.4 Protocol standard
	3.5 Reader Initialisation 
	3.5.1 I2C interface
	3.5.2  SPI interface
	3.5.3   Serial and USB interface

	3.6  First test
	3.7 Script execution.
	3.8  General view

	4.  Script File Description
	4.1 Commands
	4.2  Comments
	4.3 Special commands line

	5.  Commands description
	5.1 Menu
	5.1.1 File Menu
	5.1.2 Edit Menu
	5.1.3  Script Menu
	5.1.4 Command Menu
	5.1.5  Protocol Menu
	5.1.6  Reader Menu
	5.1.7  View Menu
	5.1.8 Tools Menu
	5.1.9 Windows Menu
	5.1.10 Help Menu

	5.2 Toolbar
	5.3  Specific use
	5.3.1 New command (File menu)
	5.3.2 Open command (File menu)
	5.3.3  Command Setting Dialog Box
	5.3.4 Alpar USB Protocol
	5.3.5  Alpar Protocol
	5.3.6 PC/SC Protocol
	5.3.7 TAMA Protocol
	5.3.8 Standard Menu
	5.3.9 Power Menu
	5.3.10  On Async. Menu
	5.3.11 On Sync. Menu
	5.3.12 Mode Menu
	5.3.13 Loopback Menu
	5.3.14 Delay Options
	5.3.15 Cyphering


	6.  Specific USB behaviour
	6.1 Active suspend and remote wake up
	6.2 Hot detach and reattach


